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The use of symbols
The following manual includes several symbols to make it easier for you to follow.


The information symbol indicates an additional information on the action of the programme 
or on the handling with the programme.

The notice indicates an important information. Disregarding this information may affect 
actions to be performed by the programme.


The arrow indicates a pre-condition for the following action. If this pre-condition is not given, 
the programme may can not follow with the given instructions.

 The check mark indicates the result of an action.

 This symbol indicates a Glossary entry. The symbol is placed behind the corresponding word.

General notes

Modifications to the software that go beyond the scope presented in this document 
are prohibited!
Any consequences resulting from such changes will not be covered by the company.
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About this manual

1 About this manual
These operating instructions provide an introduction to the NetworkViewer plugin. The following 
instructions describe the structure of the programme and show how to use it properly.

This manual is intended for users with as well as without sound knowledge in the field of map display. 
Therefore, this manual contains in some places further information on this area, which enables the user to 
make correct settings for his purposes.

More detailed information on specific keywords can be found in the glossary.

The manual follows a logical sequence for a step-by-step familiarisation. Before using the programme, read 
this manual thoroughly.

Follow the instructions.

© 2021 femvenner GmbH 1/71



Requirements

2 Requirements

PC Requirements

PC-Hardware (Minimum)
Intel® Core™ i5, 8GB RAM, 20 GB sufficient free space on hard-drive

OS Windows 10 (32- or 64-Bit-Version)

USB-Ports 3 x USB 2.0 (used for license dongle connection, GPS-receiver and TETRA 
terminal connection)

Ethernet 10/100/1000 Mbit/s (used for internet connection to the 
openstreetmap server to download the map data)

Supported file formats for import of GPS-Data sets from Kenwood-Logger-Plugins

• Kenwood NX-5000 RSSI Log

Supported GPS-Receiver for recording of GPS-Daten used for the TETRA-RSSI-Logger-Plugin

• Navilock NL-442U

Supported TETRA-Terminals for recording of TETRA RSSI-Data used for the TETRA-RSSI-Logger-
Plugin

• Sepura STP 8038
• Sepura SRM2000, SRM/G3x00
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First steps

3 First steps
The Networkviewer-Plugin needs a valid license.

The license is provided with a hardware dongle. 

Connect the hardware dongle with the PC with the PC and make sure that the LED is red. If no light is on, 
check the driver installation.

To record TETRA RSSI data, install the drivers for the TETRA terminal (for example, for Sepura, the FTDI 
driver) and for the connected GPS receiver. 
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Start of the programme and introduction to operation

4 Start of the programme and introduction to operation
After the NetworkViewer plug-in has been started, the user interface of the NetworkViewer opens. 
Chapter 35 describes the user interface in detail. This chapter only facilitates the introduction to the 
operation of the programme.

 This description assumes that NetworkViewer can establish an internet connection to the map 
server of Openstreetmap.

The chapter contains the following procedure:

1. basic configuration of the NetworkViewer and configuration regarding access to the map server of 
Openstreetmap

2. creating a new project and importing RSSI information mapped to GPS coordinates

3. work with the displayed data

This procedure is recommended for getting started with the operation of the programme, especially for the 
first programme execution after the programme installation
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Start of the programme and introduction to operation

4.1 basic configuration of the NetworkViewer

After starting the programme for the first time, the view shown in figure 35 opens.

No maps are displayed in the view yet because access to the map server has not yet been configured.

To configure access to the map server, follow the next steps.

➔ The NetworkViewer is open.

1. Open the window for configuring access to the map server via ‚Edit‘ > ‚Settings‘.

✔ The window opens (see figure 1). In this window, settings for the standard paths, the map display, 
the map server and the colour display are possible. 

 The 'Path' tab is automatically displayed.

Figure 1 NetworkViewer: Settings – Path


The 'Default Explorer Path' is used to set the default path for the explorer, for example 
when creating a new project.
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Start of the programme and introduction to operation



Under the 'Map Path' the map sections (tiles) are stored that were downloaded from the 
map server for the display of the map from the Internet. Subsequently, this map data is 
used for the display of the map and new map sections are only loaded from the map 
server if the displayable area lies outside the stored map data or the zoom level used. 
This reduces the number of accesses to the server and enables offline map display. 

2. Set the 'Default Explorer Path' and 'Map Path' in the 'Path' tab. Any existing directories can be 
specified

3. The next step is to allow the programme to download map sections from map servers. Select the 
'Server' tab in the window. Leave the 'Server Address' and 'User Agent' unchanged, but check 
'Download Allowed'. 

Figure 2 NetworkViewer: Settings – Server

4. The changes in the window ‚Settings‘ are confirmed with ‚OK‘. 

✔ The dialogue closes and access to the map server has been configured

 The settings can be changed again at any time.
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Start of the programme and introduction to operation

✔ The main view shows a map display centred on the coordinate origin (0°, 0°).

By 'pressing' and 'holding' the left mouse button and simultaneously 'dragging', the map display can be 
moved to any coordinate. The mouse wheel can be used to zoom in or out of the map. Zooming always 
takes place at the position of the mouse pointer so that the new map view is displayed centred on the 
mouse pointer.

The NetworkViewer saves the initial coordinate for the map display. Each time the programme is started, 
the map view is centred on this initial coordinate. 

To save the initial coordinate for the map view, follow the next steps.

➔ The NetworkViewer is open.

1. Centre the map view on the desired coordinate (for example Berlin).

2. Open the window for configuring the map via 'Edit' > 'Settings'.

✔ The window opens (see 1). In this window, settings for the standard paths, the map display, the map 
server and the colour display are possible.

 The 'Path' tab is automatically displayed.

3. Select the ‚Map‘ tab. 

✔ The window displays the contents of the 'Map' tab (see 3). 
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Start of the programme and introduction to operation

Figure 3 NetworkViewer: Settings – Map

4. Press the button ‚Get Current Map Center‘.

✔ The coordinates of the map centre of the current view are entered under ‚Latitude‘ and ‚Longitude‘.

5. The changes in the window ‚Settings‘ are confirmed with ‚OK‘. 

✔ The window closes and the initial coordinate for the map view has been set.

 The settings can be changed again at any time.

✔ Each time the programme is started, the map display is now centred on the coordinate (Berlin in the 
example).
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Start of the programme and introduction to operation

With the NetworkViewer programme, the zoom level for the map display can also be limited in the settings. 
In addition, you can set the zoom level at which the RSSI information is later displayed as a point on the 
map. The default setting for the permitted zoom levels is the range from zoom level 4 to 15. By default, the 
RSSI information is displayed on the map from zoom level 9.

To change the zoom level limit for the map view in the settings, follow the next steps.

➔ The NetworkViewer is open.

1. Open the window for the configuration of the card via ‚Edit‘ > ‚Settings‘.

✔ The window opens (see 1). In this window, settings for the standard paths, the map display, the map 
server and the colour display are possible.  

 The ‚Path‘ tab is automatically displayed.

2. Select the ‚Map‘ tap. 

✔ The window displays the contents of the ‚Map‘ tab (see 4). 
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Start of the programme and introduction to operation

Figure 4 NetworkViewer: Settings – Map

3. Use ‚minimum Zoom Level‘ and ‚maximum Zoom Level‘ selection buttons to set the zoom level range 
used in the programme.


The map display of the main window can only be zoomed between the values ‚minimum Zoom 
Level‘ and ‚maximum Zoom Level‘.

4. Use the selection buttons ‚Items visibility Zoom level‘ to define the zoom level from which the RSSI 
information will later be displayed as a point on the map.

5. Confirm the changes in the ‚Settings‘ window by pressing ‚OK‘. 

✔ The dialogue closes and the settings for the zoom levels have been adopted.

The display of RSSI points on the map is only calculated for the zoom range set at the 
time of data import. This reduces the required computing capacity when processing 
larger amounts of data. 

If the zoom range is extended after the data import, the drawing of the data must be 
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Start of the programme and introduction to operation

repeated so that the change of the zoom range is also displayed on the map for the 
new zoom levels.

This completes the basic configuration of the NetworkViewer.
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The TETRA-RSSI-Logger-Plugin

5 The TETRA-RSSI-Logger-Plugin
This chapter describes how to use the TETRA-RSSI-Logger plugin. The plugin TETRA-RSSI-Logger is used to 
record RSSI data from TETRA cells with a connected TETRA terminal via its PEI interface. The current GPS 
position is determined via a connected GPS mouse and also saved. The result is a csv file that can be loaded 
into NetworkViewer with the TETRA-RSSI-Logger plugin. The collection of the data and the generation of 
the csv file is done by the programme TetraRssiLogger, which is included in the package of the TETRA-RSSI-
Logger-Plugin. 

5.1 The programme TetraRssiLogger

To record the TETRA RSSI values, follow the steps below.

➔ The dongle with the programme licence is connected.

➔ A GPS receiver is connected.

➔ A TETRA-Terminal is connected.

1. Start the programme TetraRssiLogger.

✔ The TetraRssiLogger window opens (see figure 5). 

Figure 5 TETRA-RSSI-Logger: programme

2. Open the window for setting the file path in which the csv file is written via ‚Settings‘ > ‚Change 
Logging Path‘.

✔ The window ‚Save Path‘ is opened (see figure 6). 
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The TETRA-RSSI-Logger-Plugin

Figure 6 TETRA-RSSI-Logger: Dialogue Save Path


Using the checkbox ‚Split the File‘ the recording duration per file can be set. After the 
time has expired, a new file is automatically created in which the RSSI and GPS data are 
saved.

3. Enter the path for exporting the csv file or open the file explorer with the field  to select 
the path.

4. The entries are confirmed with ‚OK‘.

✔ The csv file is saved under this directory. 

5. Open the window for setting the GPS setting for the connected GPS receiver via ‚Settings‘ > ‚Change 
GPS Settings‘.

✔ The window ‚Change GPS Settings‘ opens (see figure 7). 

Figure 7 TETRA-RSSI-Logger: Dialogue Change GPS 
Settings

6. Enter the COM-Port and the baud-rate of the GPS receiver.

7. The entries are confirmed with ‚OK‘.

✔ The window closes and the COM port is set.

8. Open the window for setting the terminal settings for the connected TETRA terminal via ‚Settings‘ > 
‚Change Terminal Settings‘.

✔ The window ‚Change Terminal Settings‘ opens (see figure 8). 
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The TETRA-RSSI-Logger-Plugin

Figure 8 TETRA-RSSI-Logger: Dialogue Change Terminal 
Settings

9. Enter the COM port of the TETRA terminal and the COM port configuration according to the TETRA 
terminal specification. (the values given in figure 8 for the baud rate, data bits, etc. correspond to 
the configuration of a Sepura terminal).

10. Confirm the entries with ‚OK‘.

✔ The window closes and the settings have been stored.

11. Use the checkbox ‚Acoustic Warning Signal‘ to select whether a warning tone is played in the event 
of an error. The button ‚Play Warning Signal‘ plays the warning tone once. This can be used to check 
the volume of the warning tone. The volume of the warning tone can be adjusted via the volume of 
the Windows loudspeaker. 

12. Start the recording of the TETRA-RSSI measured values by pressing the ‚Start‘ button.

Figure 9 TETRA-RSSI-Logger: Start of the measurement

✔ The current GPS coordinate appears with the current date and time.
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The TETRA-RSSI-Logger-Plugin

✔ The ‚Terminal information‘ contains the current TETRA registration status, the location area of the 
current cell and the current measured RSSI value of the current TETRA cell. 

✔ No error is displayed in the ‚Status GPS‘, ‚Status Terminal‘ and ‚General information‘ lines. 

13. After 5 seconds the ‚Terminal information‘ changes from ‚REGISTERED – WAIT‘ to ‚REGISTERED‘. The 
terminal reports that it is registered in the cell.

Figure 10 TETRA-RSSI-Logger: start of the measurement

✔ The GPS coordinate, the time and the terminal information are continuously updated.

✔ A csv file is created that contains the RSSI values assigned to the TETRA cells and the respective GPS 
coordinate.

 To view the contents of the csv file, use the TETRA-RSSI-Logger plugin in NetworkViewer. 

5.2 The programme NetworkViewer with TETRA-RSSI-Logger-Plugin

The NetworkViewer is programme used for displaying the TETRA-RSSI data.


The NetworkViewer can be switched to the English language via menu ‚Ansicht‘ > 
‚Sprache‘ > ‚en‘.

To display the TETRA RSSI on the map, follow the steps below. 

➔ The dongle with the programme licence is connected.

➔ The NetworkViewer is started.

➔ The basic settings for the map display have been made.
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The TETRA-RSSI-Logger-Plugin

1. Create a new project via ‚File‘ > ‚Create Project‘.

✔ The window ‚Create Project‘ opens (see figure 11). 

Figure 11 NetworkViewer: Dialogue ‚Create Project‘

2. Insert the Project-Path and/or Project name.

3. Confirm with ‚OK‘.

✔ The window closes and the project name is displayed in the upper left corner above the menu (see 
figure 12). 

4. Now load the configuration file (csv) via ‚Plugins‘ > ‚Tetra Logger‘ > ‚Load Config File‘. The 
configuration file contains the locations and parameters of the TETRA base stations such as the 
location area and channel frequency, etc. The plugin needs this information to be able to correctly 
assign the data from the TETRA terminal. This means the RSSI values measured on the individual 
frequencies are assigned to the TETRA cells and displayed accordingly. 

✔ The NetworkViewer shows the imported TETRA base stations in the data list (see figure 12). At the 
same time, a symbol for the base stations is created on the map, which contains the respective 
location area of the base station).  
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The TETRA-RSSI-Logger-Plugin

Figure 12 NetworkViewer: configuration file loaded

5. Import the RSSI readings from the measurement with the TetraRssiLogger via ‚File‘ > ‚Import‘ > 
‚Tetra Logger File…‘. In the dialogue that opens, several files can be specified separated by a 
semicolon. If the Explorer is opened, several files can also be selected here, which are automatically 
imported one after the other by the programme. The opening dialogue contains the last imported 
file.

✔ The NetworkViewer shows the processing of the data in a progress bar (see figure 13).  
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The TETRA-RSSI-Logger-Plugin

Figure 13 NetworkViewer: Import of RSSI-Data is in progress

✔ When processing is complete, the result of the import is displayed (see figure 14).
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The TETRA-RSSI-Logger-Plugin

Figure 14 NetworkViewer: Import of the RSSI-Data successful

✔ In the data list under Plugin, the grouped entries (layers) are now displayed (see figure 15).
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The TETRA-RSSI-Logger-Plugin

Figure 15 NetworkViewer: View of the Layer in the data list below Plugin

✔ The layers in the data list under Plugin contain the location area and the downlink frequencies of the 
TETRA base stations. There is one layer per downlink frequency. This layer contains all RSSI 
measurement values contained in the measurement data set (csv file), regardless of whether the 
TETRA terminal was logged into this cell or the cell was only measured as a neighbouring cell.

✔ The ‚TetraLogger‘ layer contains the RSSI values of the TETRA cells in which the TETRA terminal was 
logged in. It is therefore the layer of the best server.  

6. To draw the RSSI data on the map, select ‚Plugins‘ > ‚Tetra Logger‘ > ‚Draw Data‘. The RSSI data for 
the zoom levels specified in the ‚Map‘ tap of the ‚Edit‘ > ‚Settings‘ menu under ‚Map Zooms‘ will be 
drawn. The drawing is done for zoom levels greater than the zoom level specified in ‚Items visibility 
Zoom Level‘ and less than or equal to the zoom level specified in ‚maximum Zoom Level‘  (see 

© 2021 femvenner GmbH 20/71



The TETRA-RSSI-Logger-Plugin

Figure 4 NetworkViewer: Settings – Map). A progress bar is displayed as long as the programme is 
drawing the RSSI values.

✔ When the drawing is finished, the progress bar closes automatically. 

7. Now ckeck the layer that is to be displayed. 

✔ The NetworkViewer displays the RSSI values according to the selected layer. (see figure 16). 

Figure 16 NetworkViewer: loading a configuration file and drawing RSSI-values

✔ This completes all steps for the configuration and import of RSSI data.


Further descriptions for working with the imported RSSI data are contained in the 
chapter 7. In this chapter, the handling is explained using the Kenwood Logger Plugin as 
an example, but the functions also apply to the TETRA-RSSI-Logger-Plugin.
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The Kenwood-Logger-Plugin

6 The Kenwood-Logger-Plugin
The chapter contains a description of how to use the plugin Kenwood-Logger.

6.1 Import of test points

To import RSSI information from a file, a project must first be created. To create a project, follow the steps 
below.

➔ The NetworkViewer is open

➔ The NetworkViewer has been configured to access the map server.

➔ The Kenwood Logger plugin has been loaded into the programme.

1. Open the window for creating a project via ‚File‘ > ‚Create Project‘.

✔ The window opens (ses 17). 

Figure 17 NetworkViewer: create a new project

2. Enter the name of the new project and, if necessary, change the path under which the project is 
created.

3. The entries are confirmed with ‚OK‘.

✔ A directory with the project name is automatically created. The project is saved under this directory. 
The name of the currently loaded project is displayed in the top line of the programme.

Then the RSSI information can be imported from a file. 

To import the RSSI information from a file, follow the next steps.

➔ The NetworkViewer is open.

➔ The NetworkViewer has been configured to access the map server.

➔ The Kenwood Logger plugin has been loaded into the programme.

➔ A project has been created or loaded.

1. Select ‚File‘ > ‚Import‘ > ‚Kenwood Logger File‘.

© 2021 femvenner GmbH 23/71



The Kenwood-Logger-Plugin

✔ A window for selecting the file opens (see figure 18). 

Figure 18 Kenwood-Logger: Import RSSI informations from a file


The ‚Default Explorer Path‘ is used to set the default path for the explorer, for example, 
for creating a new project.

2. Enter the path and file name for importing the RSSI information or open the file explorer using the 
field to select the file

3. Check the checkbox ‚Loaded values in dBm‘ to display the RSSI values read in the unit dBm. 
Otherwise the RSSI values are displayed with the unit dB.

4. The import of the file is started with ‚OK‘. 

✔ The window closes and a window (see figure 19) with the number of records found in the imported 
file is displayed.

Figure 19 Kenwood-Logger: result of file 
import

 A data set consists of a GPS coordinate with time, an assigned RSSI value and, if applicable, a BER 
value.

✔ The file name of the imported file is displayed in the ‚Data List‘  below ‚Plugin‘.
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The Kenwood-Logger-Plugin

Figure 20 Kenwood-Logger: view after importing an RSSI file

The imported file name is indicated in the data list under ‚Plugin‘. With the check mark in front of the file 
name, the display of the RSSI information imported from this file can be shown or hidden. With a left click 
on the file name in the ‚Data List‘ the data set can be removed from the project (left click on the file name 
(in figure 20 „20180117_114719_GPS“) > ‚Delete‘).

In figure 20 the zoom level 6 is used for the display (bottom left in the main window). To see the imported 
RSSI information, the zoom level must be higher than the ‚Items visibility Zoom level‘  in the ‚Edit‘ > 
‚Settings‘ menu in the ‚Map‘ tab (in the example, the zoom level must be higher than 9).
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The Kenwood-Logger-Plugin

To display the imported RSSI information on the map, follow the steps below: 

➔ The NetworkViewer is open.

➔ The NetworkViewer has been configured for map access to the map server

➔ The Kenwood Logger plugin has been loaded into the program.

➔ RSSI information has been imported from a file.

1. Display the ‚Data List‘ window by checking ‚Windows‘ > ‚Data List‘ or by pressing the button ‚Toggle 
Data list View‘ (see chapter 8 point 6j) in the quick access bar.

✔ The window ‚Data List‘ is displayed. 

2. Zoom into the map display until the zoom level is higher than the ‚Items visibility Zoom level‘ in the 
menu ‚Edit‘ > ‚Settings‘ in the‚Map‘ tab (in the example the zoom level must be higher than 9). Either 
the mouse wheel or the ‚Zoom In‘ button is used for this (see chapter 8 point 4j).

3. Left click on the filename of the imported file and select ‚Center on‘.

or

4. Click with the right mouse button on the file name of the imported file. The button ‚Center On‘ 
appears in the quick access bar, which you then press.

✔ The map view now shows the imported RSSI information.
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The Kenwood-Logger-Plugin

Figure 21 Kenwood-Logger: display of the RSSI values and the legend

The current coordinate can be saved as the start coordinate using the button ‚Get Current Map Center‘ in 
the menu ‚Edit‘ > ‚Settings‘ in the tab ‚Map‘. 

This centres the map view on the current map view when the programme is started.

If the project is closed ‚File‘ > ‚Close Project‘ or the programme is closed directly via ‚File‘ > ‚Close‘, the 
current map view and the current zoom level are saved in the project. If the project is reloaded using ‚File‘ > 
‚Recent File‘ > Project-FIle or via ‚File‘ > ‚Open Project File‘, this last map view is displayed again.

This completes the import of RSSI information from a file.

© 2021 femvenner GmbH 27/71



Working with the displayed RSSI-Data

7 Working with the displayed RSSI-Data
This chapter explains the possibilities of working with the imported RSSI data.

Figure 22 NetworkViewer: Tooltip RSSI values

For each data set (GPS position + time information + RSSI + BER, if applicable), one point is displayed in the 
respective colour according to the RSSI gradation set (see legend 'Map Legend'). If several points are on top 
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of each other, the point with the highest RSSI is displayed. The values of the points below can be displayed 
with the help of the mouse pointer.

If the mouse pointer is over an RSSI point, a window (tooltip) is displayed in which the RSSI information is 
assigned to the GPS coordinates and the time. If several points lie on top of each other, only a maximum of 
4 data records with the highest RSSI values are displayed.

For further resolution, you can now zoom into the map display (using the mouse wheel or the magnifying 
glass symbols +/- at the top right).

The display of the points is determined by the programme for each zoom level 
permitted in the 'Settings' (see Chapter 4.1) at the time of the file import. If the 
'maximum zoom level' is increased after importing the data, no RSSI points are 
displayed for this zoom level. This can be remedied by importing the data again 
after the permitted zoom level has been increased in the 'Settings'.
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Figure 23 NetworkViewer: Tooltip RSSI values Zoom

In figure 23 the tooltip of the left yellow dot is shown. The RSSI measurement resulted in a value of -98 
dBm; according to the legend, the reception field strength is less than -95 dBm but greater than -110 dBm 
and is shown in yellow.

The subdivision of the RSSI values and their colour display can be set in the menu under ‚Plugins‘ under the 
respective Plugin below ‚Options‘ (see chapter 8.7.1).

If the imported data also contains BER values or other plugin-specific values (for example, the LA of the 
TETRA-RSSI-logger plugin), these are also displayed in the tooltip. For example, the following figure 24 
shows that 44.73% of the received bits were received correctly in the specified second. The remaining bits 
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were changed during the signal transmission. These BER values are a direct measure of the signal quality, 
measured by the receiving terminal.

Figure 24 NetworkViewer: Tooltip BER values

7.1 Export of the map view as file

 The map view can be exported as an image file. 

To export the current map view as an image file, follow the steps below: 

➔ The NetworkViewer is open.

➔ The NetworkViewer has been configured for map access to the map server.

➔ The Kenwood-Logger-Plugin was loaded into the programme.

➔ RSSI information was imported from a file.

➔ The map section and zoom level were selected so that RSSI values are displayed as points on the 
map.

1. Select ‚Edit‘ > ‚Save View to Image‘.

✔ The file explorer opens. 

2. Set the file type for the image file to be saved. The image file formats png and jpeg are supported. 

3. Select the destination directory and enter the file name.

4. Confirm the saving with ‚Save‘.

✔ The image file has now been saved in the specified directory under the specified file name.
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7.2 Centring the map view with the help of the ‚Data List‘

If several files have been loaded, each containing RSSI information from different locations, the map view 
can be centred on the respective location. With a left click on the file name in the ‚Data List‘ (in figure 23 
„20200825_103721_GPS“) > ‚Center On‘ the map view can be centred on the data set. 

7.3 GPS bookmarks

GPS bookmarks can also be inserted. With a right click on the map > ‚Create GPS-Bookmark‘ a window 
opens where the name of the bookmark can be entered. The bookmark saves the GPS position of the right 
click and the current zoom level. This bookmark then appears in the menu below ‚Bookmarks‘ and can be 
used as a jump marker. If the bookmark is selected beneath ‚Bookmarks‘ > ‚bookmark name‘, the map 
display is centred on the saved GPS coordinate and the saved zoom level is set. The GPS bookmarks can also 
be edited and deleted again via the ‚Bookmark‘ menu.

7.4 Offline maps

For the use of offline maps, it is possible to define a map section, download it from the map server and save 
it. The saved map data are automatically used for the map display and independently of a loaded project. 
The use of saved map data has priority over the map data downloaded from the map server.

To specifically download a map section from the map server, follow the next steps.

➔ The NetworkViewer is open.

➔ The NetworkViewer has been configured for map access to the map server.

1. In the main window, define the map section you want to download specifically from the map server 
by moving and zooming.

2. In the menu, select ‚Edit‘ > ‚Cache Tiles‘.

✔ The window ‚Cache Tiles‘ opens (see figure 25). 
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Figure 25 NetworkViewer: loading maps used for offline map view

 The map shown is only an image and does not change.

3. Press the button ‚set Map View‘ to take over the corner coordinates of the current map view of the 
main window. 

✔ The window now shows the north-western and south-eastern coordinates of the current map view.

4. In the list on the left, select the zoom level for which the map material is to be downloaded from the 
map server.

✔ Above the buttons, the number of tiles already in the cache and the amount of data needed to 
download the remaining tiles are displayed for the selected zoom level. Below the list of zoom 
levels, the bar graph also shows the ratio of map data already loaded and still to be loaded for the 
selected zoom level.

 The larger the zoom level, the larger the amount of map data.

5. Start the download of the tiles not yet loaded for the selected zoom level by pressing the button 
‚Load Remaining‘.

or
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6. Start the download of all tiles for the selected zoom level by pressing the ‚Load All‘ button. This also 
overwrites map data already in the cache. 

✔ The tiles are downloaded.

7. Repeat steps 4 to 6 for each desired zoom level.

8. Press the button ‚Close‘.

✔ The dialogue closes and access to the map server has been configured.

Openstreetmap reserves the right to permanently prevent excessive data traffic 
requested by a single computer. It is therefore recommended to handle the stored 
map data with care.
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8 User interface NetworkViewer
This chapter gives an overview of the user interface of NetworkViewer. After starting the programme for the 
first time, the main view shown in figure 26 opens.  

Figure 26 NetworkViewer: user interface overview

No description

1j Field with the representation of the map and the imported data.

2j Opens the dialogue for opening an overlay file.

3j Display of the current zoom level and the GPS coordinate of the current mouse cursor.

4j Zoom in and out in the map display. Alternatively, the mouse wheel can be used.

5j ‚Toggle Map Legend View‘ – shows or hides the legend.
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No description

6j ‚Toggle Data list View‘ – shows or hides the data list.

7j ‚Toggle Informations View‘ – shows or hides the information docking window.

8j
‚Toggle Star View‘ – shows or hides the star graph for displaying the neighbourhood 
relations between neighbouring TETRA cells.

Table 1 NetworkViewer: User interface overview

8.1 Docking windows

This chapter provides an overview of the different docking windows in the NetworkViewer.

Data list

Figure 27 NetworkViewer: Data list

No description

9j Button to select all items.

10j Button to reset the selection of items.

11j Search bar to search for elements in the list. All elements found are marked.

12j The list containing the Base stations.
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No description

13j
List with the plugin-specific objects (shown here is the list with the grouped entries of the 
TETRA RSSI Logger plugin).

14j The Overlay list shows the load overlay files.

15j Die Mark list contains the marks.
Table 2 NetworkViewer: Data list

Information

Figure 28 NetworkViewer: Information

No description

16j
Button to copy the information of the selected item (in the tower list or the mark list) to the 
clipboard.

17j Button to copy the selected Information to the clipboard.

18j Information of the marked item. This can be a Base station from the Tower list or a mark.
Table 3 NetworkViewer: Information
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Star View (only RecordFile-Plugin)

Figure 29 NetworkViewer: Star View

No description

19j
Logical links between the Base Stations. The references are shown in colour. The colours are 
explained in the map legend. 

20j Base Stations distinguished by the location area of the respective station.
Table 4 NetworkViewer: Star Graph

The Star Graph shows the logical links between the TETRA Base Stations. The TETRA Base Stations reference 
to their neighbouring cells on the air interface. The RecordFile plugin reads in record files from the 
MultiAnalyzer (maf files) and evaluates the neighbourhood relations of the TETRA cells among each other. 
The result is displayed both directly in the map view and in the Star Graph.The TETRA Base Stations show 
their neighbouring cells on the air interface.  The RecordFile plugin reads recording files from the 
MultiAnalyzer (maf files) and evaluates the neighbourhood relations of the TETRA cells among each other. 
The result is displayed both directly in the map view and in the Star view. For the Star Graph, a Base Station 
must be selected in the data list or in the map display.

Different colours are used for the representation of the neighbourhood relations. The colour representation 
is identical both in the map view and in the Star Graph view and can be specified in the settings (see Figure 
53). In the illustrations, "mismatch" means that there is no mutual reference between the TETRA cells. That 
is, TETRA cell A identifies TETRA cell B as a neighbouring cell, but TETRA cell B does not contain TETRA cell A 
as a neighbour. Thus, terminals would be able to switch from cell A to cell B, but conversely, terminals 
cannot switch from cell B to cell A. "Incomplete", on the other hand, means that the recording files of both 
TETRA cells have not yet been read in and therefore the mutual neighbourhood relationship cannot be 
assessed by the programme. For example, if only the recording file of cell A has been imported, but not that 
of cell B, the reference between cell A and B is shown as "incomplete". A mutual designation of the TETRA 
cells among each other is indicated by "link".
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Map Legend

Figure 30 NetworkViewer: Map Legend

No description

21j
This section shows the description of all colours used for the logical connection of the 
towers in the display on the map as well as in the star view.

22j
This excerpt shows the legend for the colour gradations of the RSSI values of a plug-in 
(TETRA RSSI logger plug-in or Kenwood logger plug-in).

Table 5 NetworkViewer: Map Legend
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8.2 Menus of the NetworkViewer

This chapter describes the contents of the menus in detail.

Menu ‚File‘

Figure 31 NetworkViewer: Menu ‘File’

Name Short cut description

Create Project none Opens a dialogue for creating a project.

Open Project File... none Opens an already existing project.

Recent Files none
Displays the most recently used project files and opens 
the associated project when the file is clicked.

Import none Imports overlay files or files for the plug-ins. 

Tetra Towers... none

Imports the TETRA cell data from a csv file. 


This button is only available if the 
programme supports the RecordFile Plugin 
option.

Overlay... none Loads an overlay file.

Kenwood Logger File... none

Imports the RSSI/BER data from a file.


This button is only available if the 
programme supports the Kenwood Logger 
Plugin option.
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Name Short cut description

MultiAnalyzerRecord... none

Imports the data from a MultiAnalyzer record file. 
Supported record files have the file extensions *.maf, 
*.lan or *.tmw.


This button is only available if the 
programme supports the RecordFile Plugin 
option.

Tetra Logger File... none

Imports the data from a TetraRssiLogger-record file. The 
file has the file extension *.csv.


This button is only available if the 
programme supports the TETRA-RSSI-
Logger-Plugin.

Rename Project none
Opens a dialogue for renaming the currently opened 
project.

Close Project none Closes the currently open project.

Close Ctrl+F4 Exits the programme.
Table 6 NetworkViewer: Menu ‘File’
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Menu ‚Edit‘

Figure 32 NetworkViewer: Menu ‘Edit’

Name Short cut description

Save View to Image None
Saves the current map view as an image file. In the 
dialogue that opens, the name of the image file as well 
as the file type can be specified.

Save Star View to Image None
Saves the current Star Graph as an image file. In the 
dialogue that opens, the name of the image file as well 
as the file type can be specified.

Copy View to Clipboard None Saves the current map view to the clipboard. 

Copy Star View to Clipboard None Saves the current Star Graph to the clipboard.

Cache Tiles None
Opens the dialogue for downloading map data based 
on the map section entered and the desired zoom 
level.

Settings None Opens the dialogue for the programme settings.
Table 7 NetworkViewer: Menu ‚Edit‘
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Menu ‚Windows‘

Figure 33 NetworkViewer: Menu 
‘Windows’

Name Short cut description

Data List none Shows or hides the window with the Data list.

Information none Shows or hides the window with the Information.

Map Legend none Shows or hides the window with the Legend.

Toolbar none Shows or hides the Toolbar.
Table 8 NetworkViewer: Menu ‚Window‘
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Menu ‚Bookmarks‘

Figure 34 NetworkViewer: Menu ‘Bookmarks’

Name Short cut description

Home none
GPS bookmark created by the user as a jump mark for 
the map display. GPS bookmarks can be created by 
right-clicking on the map display.

Edit GPS-Bookmarks none
Opens a dialogue in which the GPS bookmarks can be 
edited. Created bookmarks are displayed in the 
'Bookmarks' menu.

Delete all GPS-Bookmarks none Deletes all existing GPS bookmarks.
Table 9 NetworkViewer: Menu ‚Bookmarks‘
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Menu ‚Plugins‘

Figure 35 NetworkViewer: Menu ‘Plugins’

Name Short cut description

Kenwood Logger none

Contains the buttons for the Option Kenwood-Logger-Plugin. 


This button is only available if the programme 
supports the option Kenwood-Logger-Plugin.

Options none
Opens a dialogue for entering the RSSI ranges and their 
colour assignment for the coloured display of the RSSI values 
(see chapter  8.7.1 )

RecordFile none

Contains the buttons for the option RecordFile-Plugin.


This button is only available if the programme 
supports the option RecordFile-Plugin.

Edit Data none
Opens a dialogue with which the imported data of the TETRA 
cells can be edited.

Load Config File... none

Opens the file explorer with which the configuration file can 
be loaded. The configuration file contains the locations as 
GPS position, names and other parameters of the TETRA Base 
Stations. The GPS positions of the Base Stations therefore do 
not have to be entered manually.
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Name Short cut description

Tetra Logger none

Contains the buttons for the option TETRA-RSSI-Logger-
Plugin.


This button is only available if the programme 
supports the option TETRA-RSSI-Logger-Plugin.

Options none
Opens a dialogue for entering the RSSI ranges and their 
colour assignment for the coloured display of the RSSI values 
(see chapter  8.7.3 )

Draw Data none Starts drawing the RSSI points on the map.

Load Config File... none

Opens the file explorer with which the configuration file can 
be loaded. The configuration file contains the locations as 
GPS position, names and other parameters of the TETRA Base 
Stations with which an assignment of the RSSI measured 
values to the Base Stations is possible.

Table 10 NetworkViewer: Menu ‚Plugins‘
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Menu ‚View‘

Figure 36 NetworkViewer: Menu ‘View’

Name Short cut description

Open User Guide none Opens the user manual.

Language none
Switching the menu language. The supported 
languages are displayed and can be selected.

About Qt... none
Displays information about Qt such as the version 
number.

About NetworkViewer... none
Displays information about the NetworkViewer such as 
the version number.

Table 11 NetworkViewer: Menu ‚View‘
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8.3 The pop-up menu

The respective pop-up menu can be reached with the right mouse button. There is a pop-up menu for the 
map display, the 'Information' window and for the 'Star Graph' window. 
In the 'Information' field, data can be copied to the clipboard via the pop-up menu. There is also a menu 
item to select all entries in the 'Information' window and copy them to the clipboard. 
The pop-up menu in the 'Star Graph' window offers the option to save the display as an image or to save the 
display to the clipboard.

Figure 37 NetworkViewer: pop-up menu of the map 
display

Name Short cut description

Save View to Image none
Saves the map view with the legend as an image. The 
file explorer opens, in which the file name and the 
storage location are specified.

Copy View to Clipboard none
Copies the map view with the legend as an image to 
the clipboard. 

Create GPS-Bookmark none

Creates a GPS bookmark at the position of the mouse 
click (right mouse button). The GPS bookmark is 
entered in the 'Bookmarks' menu (see Figure 44) and 
can also be edited and deleted via this menu.

Copy GPS-Position none
Copies the GPS position of the mouse click (right 
mouse button) to the clipboard.

Create Mark none
Creates a mark at the position of the mouse click (right 
mouse button). The mark is entered in the data list.

Table 12 NetworkViewer: pop-up menu in the map display
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8.4 Programme settings in dialogue ‚Settings’

In the 'Settings' dialogue there are the tabs 'Path', 'Map', 'Server' and 'Colour', which are shown below.

8.4.1 Settings in the ‚Path’ tab

In the 'Path' tab, the default paths can be set. This concerns the path that is displayed when opening the file 
explorer and the path under which the map data is saved.

Figure 38 NetworkViewer: dialogue Settings – Path

No description

9j Setting the default path for the file explorer, for example, for creating a new project.

10j
Path under which the map data is saved. Saved map data is not downloaded from the map 
server. This reduces access to the server and enables offline map display.

11j Imports all settings from a text file.
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No description

12j Exports all settings to a text file.

13j Confirms the changes and closes the dialogue.

14j Discards all changes and closes the dialogue.
Table 13 NetworkViewer: dialogue Settings – Path

8.4.2 Settings in the ‚Map’ tab

In the 'Map' tab, settings can be made for the display of the map.

Figure 39 NetworkViewer: dialogue Settings – Map

No description

15j

Text box to set the pixel size of a single map tile.

 The tile size is a server-specific parameter and specifies the size of a tile in pixels 
(e.g. 256 means that a tile consists of 256x256 pixels).
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No description

16j
Set the initial coordinate for the map display. The position of the red thread cross or the 
centre of the map is entered under 'Latitude' and 'Longitude'. When the programme is 
started, the map view is centred on this coordinate.

17j Set initial coordinate for the map display.

18j

The minimum and maximum zoom level to which the map display may be enlarged or 
reduced.

 A reduction in the amount of map data downloaded from the map server can be 
achieved by limiting the allowed zoom level range.

19j

The zoom level from which items such as towers, markers or RSSI points are displayed on 
the map.

 This setting serves to clarify the display of the items on the map.

20j Shows or hides the red cross hairs in the map view.

21j Activates/deactivates GPS reception via a GPS mouse connected to the PC.

22j Text field to specify the COM port of the GPS mouse connected to the PC.

23j Text field to set the baud rate of the GPS mouse connected to the PC.
Table 14 NetworkViewer: dialogue Settings – Map
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8.4.3 Settings in ‚Server’ tab

The settings in the 'Server' tab concern access to the map server.

Figure 40 NetworkViewer: dialogue Settings – Server

No description

24j Text field to set the server address of the map server.

25j Text field for entering the user agent used to log in to the map server. 

26j
Checkbox to activate or deactivate the internet download for the map data. If the checkbox 
is not selected, the map is only loaded from the local cache (specified in the 'Path' see 10j in 
Figure 49).

Table 15 NetworkViewer: dialogue Settings – Server
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8.4.4 Settings in the ‚Color’ tab

The colour display is configured in the 'Colour' tab.

Figure 41 NetworkViewer: dialogue Settings – Colour

No description

27j
Colour selection for the representation of the marks. Right-click on the respective colour to 
open the dialogue for changing the colour.

28j
Colour selection for the representation of the towers. Right-click on the respective colour to 
open the dialogue for changing the colour.

29j
Colour selection for the representation of the towers with a one-sided or mutual 
misconfiguration regarding the designation of the neighbouring cells. Right-clicking on the 
respective colour opens the dialogue for changing the colour.

30j
Colour selection for the representation of the connecting lines between the towers. Right-
clicking on the respective colour opens the dialogue for changing the colour.

31j
Colour selection for the display of the grouped towers. Right-clicking on the respective 
colour opens the dialogue for changing the colour.
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No description

32j
Colour selection for the display of the overlay. Right-click on the respective colour to open 
the dialogue for changing the colour.

Table 16 NetworkViewer: dialogue Settings – Colour

8.5 Map data saving with ‚Cache Tiles’

Map data can be downloaded specifically from the map server. This enables the map to be displayed even if 
the PC is not connected to the internet (offline map operation). In addition, saving map data in this way 
saves transmission capacity when downloading maps from the map server.

To download map data from the map server, select ‚Edit‘ > ‚Cache Tiles‘. The window shown in figure 27 is 
opened.
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Figure 42 NetworkViewer: User interface Cache Tiles

No description

33j Northernmost and easternmost coordinates of the selected map section.

34j Set the current map section selected in the main view.

35j Zoom level of the maps to be downloaded.

36j Southernmost and westernmost coordinates of the selected map section.

37j

Information about the map information already available in the cache for the currently 
selected map section and zoom level in the format: number of existing tiles - number of 
required tiles / existing amount of data - required amount of data (percentage of already 
existing data). The map display is composed of tiles. The higher the resolution of the map, 
i.e. the higher the zoom level, the higher the number of tiles required for the display.

38j Information about the map information already in the cache as graphic output. 
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No description

39j
Start of the download of the map data still required for the currently selected map section 
and zoom level.

40j
Start of the download of all map data for the currently selected map section and zoom 
level. The existing map data is overwritten.

41j Closes the dialogue.
Table 17 NetworkViewer: user interface Cache Tiles

The saved map data is automatically used for the map display and independently of a loaded project. The 
use of saved map data has priority over map data that must be downloaded from the map server.

8.6 The data list

In the docking window „Datenliste“, information about the TETRA cells (towers), the grouped entries 
(layers) below the plugin, the loaded overlays and the created marks are displayed depending on the loaded 
plugin. 

In the data list, a right-click on the entry of a TETRA cell, a layer or a mark can be used to centre the map 
view on the respective entry. In addition, right-clicking on an item in the data list deletes the item.
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8.7 Plugin specific configuration 

Depending on the Plugin loaded, there are various additional settings. These are presented in this chapter.

8.7.1 Kenwood-Logger-Plugin

The dialogue for the settings of the KenwoodLogger plugin can be opened in the menu below ‚Plugins‘ (see  
figure 45). 

Figure 43 NetworkViewer: user interface Kenwood-Logger-Options

No description

42j Column with the respective name of the range.

43j Column with the respective minimum of the range.

44j Column with the respective maximum of the area.

45j Column with the respective colour assigned for the representation of the points of the area.

46j Deletes the selected line.

47j
Opens a new line for entering the name, the numerical values as well as the colour for the 
representation of a new area.
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No description

48j Closes the dialogue without saving the changes.

49j Saves the changes and closes the dialogue.
Table 18 NetworkViewer: user interface Kenwood-Logger-Options

The new settings of the Kenwood Logger plugin will only take effect when the data 
is re-imported.

8.7.2 RecordFile-Plugin

Using the RecordFile-Plugin record files (maf-files) recorded by the MultiAnalyzer can be imported. The 
NetworkViewer then offers to enter GPS coordinates of the TETRA cells found in the file (figure 44) and 
displays the position of the TETRA cells on the map. In addition, NetworkViewer examines the 
neighbourhood relations of the TETRA cells among each other and also displays them graphically. The 
RecordFile plugin also offers the possibility to load a configuration file. This file contains the names and GPS 
positions of the TETRA cells. After loading the configuration file, the GPS coordinates and names of the 
TETRA cells no longer have to be entered manually. The dialogue in figure 44 is only displayed after 
importing the recording file(s) if TETRA cells were found in the recording file that were not included in the 
configuration file. It is recommended to load the configuration file first (see menu ‚Plugins‘ in figure 35 
‚RecordFile‘ > ‚Load Config File…‘) before importing the record files. 
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Figure 44 NetworkViewer: user interface RecordFile Edit Data

No description

50j Column with the respective Mobile Country Code of the TETRA cell.

51j Column with the respective Mobile Network Code of the TETRA cell.

52j Column with the respective Location Area of the TETRA cell.

53j Column with the respective name of the TETRA cell.

54j Column with the respective Latitude of the TETRA cell.

55j Column with the respective longitude of the TETRA cell.

56j Closes the window without saving the changes.

57j Saves the changes and closes the window.
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Table 19 NetworkViewer: user interface RecordFile Edit Data

The file explorer for importing the recording files allows the simultaneous import of several files. Several 
recording files can be selected for import in the file explorer with the help of the shift key or the control key 
(Ctrl). When the „Open“ button is pressed, the selected files are automatically imported one after the other. 
The last file name is saved and displayed in the file explorer when the import of the recording files is carried 
out again. 

The dialogue for entering the names and GPS positions of the TETRA cells can also be opened after 
importing the record files below ‚Plugins‘ > ‚RecordFile‘ > ‚Edit Data...‘ (see figure 35).

8.7.3 TETRA-RSSI-Logger-Plugin

The dialogue for the settings of the RSSI-Thresholds of the TETRA-RSSI-Logger-Plugin can be opened in the 
menu below ‚Plugins‘ (see figure 35). 

The ‚CRS‘ fields shown on the map mark cell change locations. If the mouse pointer is over such a field, a 
window (tooltip) is displayed in which the change of the location area assigned to the GPS coordinates is 
shown. If the cell change of the terminal takes longer (for example, due to an authentication in the new 
cell), the terminal signals an unregistered state for about 1s. This state represents the terminal MMI 
behaviour for services during this time. As long as the terminal is not registered in the new cell, it can 
neither receive nor send services (calls, SDS, ...). All unregistered states are displayed with location area (LA) 
= 0 in the tooltip and in the information field. Thus, longer sections with LA = 0 indicate that the terminal 
was outside the TETRA coverage area.
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9 Glossary

B

BER Bit Error Rate
Bit error rate given as a percentage. It is a 
measure of the signal quality. The lower the 
BER, the higher the signal quality. 

D

DMR Digital Mobile Radio

Dongle - A copy-protected hardware.

L

LA Location Area

M

Mark -
Marker that can contain data (e.g. cell change 
location) and is displayed on the map.

MCC Mobile Country Code

MNC Mobile Network Code

N

NXDN Next Generation Digital Narrowband

O

OSM Open Street Map
OpenStreetMap is an international project 
created with the aim of creating a free map of 
the world.

R

RSSI Received Signal Strength Indication
Indicator for the reception filed strength given 
in dBm or dB

T

Tiles - Also called tiles or tile graphics, tiles are 
individual parts of a high-resolution raster 
graphic. The tiles are transmitted individually 
via the internet and reassembled on the 
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computer.

Tower -
Transmission mast of the base station 
associated with the received broadcast data.
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